
Microsoft® 

Windows 10 
Quick Reference Card 
Start Menu Keyboard shortcuts 

                    

Basic Commands 

Start Menu 

Copy a Folder/File      Ctrl + C 

Cut a Folder/File         Ctrl + X 

Paste a Folder/File     Ctrl + V 

Cortana (speech) + C

Cortana (text) + S

Actions Center + A

Task View + Tab

Close App Alt + F4 

Lock computer + L

Print Ctrl + P 

File Explorer + E

Run dialog box + R

 Settings Shortcuts 

Open Settings + I

Devices pane + K

Sharing pane + H

Display options for + P
second screen 

Quick Link menu + X

 Desktop shortcuts 

Desktop  + D 

Maximize  +   

Minimize/Restore  +   

Switch between apps  Alt + Tab 

Minimize all windows   + M 

Snap app to left  +   

Snap app to right  +   

New Desktop  + Ctrl + D

Close Current Desktop + Ctrl + F4

Switch Desktops      + Ctrl +  /

Start Menu Apps
 To Open the Start Menu: Click the Start button. Or,

press .
 To Resize App Tile on the Start Menu: Right-click

a tile, click Size and select a size.
 To Rearrange Tiles: Tiles are organized into groups

of related apps. Drag a tile to a new location in a
group, or drag it between groups to start a new
group.

 To Remove a Tile from the Start Menu: Right-click
the tile and click Unpin from Start.

 To Add a Tile to the Start Menu: Right-click the
app and select Pin to Start.

 To Stop Updating an App’s Live Tile: Right-click
an app’s tile and click Turn live tile off.

 To Search for Files or Apps: Click within the
Search field and type a keyword for the file or app.
Search results are displayed in the menu.

 To Rename Live Tile Groups: Click the Live Tile
group’s name, and type in a new name.

 To Lock Your Computer: Click the Account button
and select Lock.

 To Sign Out of Windows: Click the Account button
and select Sign Out.

 To Switch Users: Click the Account button and
select another user account.

 To Change Account Settings: Click the Account
button and select Change Account Settings.

 To Launch an App: Find and click the app’s tile on
the Start menu.  Or, select All Apps from the Start
Menu and select the app you want to open.

 Jump to Different Apps: In the All Apps list click a
letter header, then select another letter, to display all
of the apps that begin with that letter.

 To Search for an App: Click within the Search field
and type a keyword for the app.

 To View All Installed Apps: Select All Apps from
the Start Menu.

 To Close an App: Click the Close button in the top-
right corner of the app. Or, press Alt + F4.

 To Jump to an Open App: Click the Task View
button. Or, press  + Tab. Note: Right-click an app
and click Close to close it.

 To Install an App: Install apps from the Windows
Store, media such as DVDs, or download from the
Internet.

 To Uninstall an App: Click the Start button and
select Settings from the Start Menu. Click the
System category and select Apps & features.
Select the app that you want to install and click the
Uninstall button.

Account 
Click to switch to another 
account, lock the computer, 
or sign out 

Most frequently 
used apps 

Start button 
Click here to open 
the Start menu 

Live Tiles 
Click a tile to 
open an app 

All Apps 

Settings 
File Explorer 

Power 

Cortana 
Search for apps, files, or folders by typing in 
keywords, or saying the terms you’re looking for 

Named Groups 
Tiles are organized 
into groups 
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Desktop File Explorer 
 
 

 

 To Peek at Open Windows: Point to a program icon on the taskbar. Point at
the resulting thumbnail preview to peek at the window.

 To Minimize Other Windows: Press + Home.  Or, click and shake a
window's title bar quickly from side to side.

 To Compare Windows Side by Side: Click and drag a window's title bar to
the right side of the screen, and select a window thumbnail for the left side of
the screen. Or, press  +   or   +  .

 To Maximize an Open Window: Click the window's Maximize window. Or,
press  +  .

 To Switch Between Apps: Press Alt + Tab to move quickly between open
programs and windows on the desktop. Or, press + Tab to open Task 
View, and select a window thumbnail. 

 To Access Settings: Click the Start button and select Settings from the
Start menu.

 To Pin a Program to the Taskbar: Pin your favorite desktop apps to the
taskbar so you can open them from within the desktop. Open the program you
want to pin, right-click the program icon on the taskbar and select Pin this
program to taskbar.

 Settings and Personalization 
 To Personalize your PC: Click the Start button, select Settings from the

Start menu, and click the Personalization category from the Settings app.

 Change Background – Choose built-in colors and pictures, or use your own.
Select more than one picture to start a slide show.

 Change Colors – Change window color and transparency.

 Change Lock screen: Change the image that appears when the screen is
locked. 

 Change Start: Change what apps appear on the Start Menu.

 Change Themes: Change Windows’s color scheme.

 

    

                                    
                 

 Action Center 

 To Display Notifications: Click the Notifications icon on the taskbar, or
swipe in from the right side of the screen on a touchscreen, to open the
Notification Center. 

 Collapse Actions Center: Click Collapse to collapse the actions down to
only the top row. The top row can be customized in the Settings app, so
you can control which four actions are available when the list is collapsed. 

 Available actions include:
o All Settings:  Opens the Settings app.
o Airplane Mode: Toggling on will turn off all radios.
o Battery Saver: Toggles battery saver mode, dimming the screen and

applying other settings to save power.
o Bluetooth: Toggles Bluetooth radio on/off.
o Brightness: Adjusts your screen’s brightness between 100%, 75% 

50%, and 25%.
o Connect: Connects to wireless devices (ie. Bluetooth).
o Location:  Toggles location services on/off.
o Note:  Opens a new note in MS OneNote.
o Quiet Hours:  A Do Not Disturb mode which blocks notifications

from appearing. 
o Rotation Lock: Locks portrait or landscape views in tablet

computers.
o Tablet Mode: Toggles tablet mode, which makes the computer act

more like Windows 8 and includes full-screen apps, bigger touch
targets, the Start Screen replaces the Start Menu, etc.

o VPN : Displays VPN settings in the Settings app.
o WiFi:  Toggles wifi on/off (not used to find a network).

 Cortana 

 Cortana allows you to search for apps, files, or folders by typing in
keywords, or saying the terms you’re looking for.

 You can use Cortana’s speech recognition by clicking the microphone
button and saying the terms you’re looking for.

 To open Cortana, click in the Cortana field to the right of the Start button.

 Cortana will display the results that she thinks are relevant.

 You can control your search results in Cortana’s Notebook.

Title bar 
Click and drag to 
move the window 

Address bar 
Displays the location of the 
folder that is currently open 

Search box 
Enter keywords to 
search the folder. 

Ribbon 
Displays buttons 
and menus for 
common 
commands 

Navigation Pane 
Provides quick 
navigation to 
folders and files. 
Browse to favorite 
locations, libraries, 
OneDrive, This PC, 
and the network 

Display Settings 
Choose how you want the content 
within the File Explorer to display 

Notification area: The Action 
Center, clock, and other system 
icons are located here. 

Show Desktop button:
Point or click here to
make open windows

invisible.

Window preview:  
Point to the program icon on the taskbar. Click 
a preview thumbnail to view the window.

Program icon: Click to 
open the program. 
Rearrange icons by 
clicking and dragging. 

Task View button: Click to view 
all of the open windows in Task 
View. 

Cortana:  
Click to open Cortana 
to search for items. 
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Microsoft® 

Windows 8 
Quick Reference Card 
Start screen Keyboard shortcuts 

Start Screen and  
Charms Bar 
Start screen/jump to < > 
previous app from  
Start screen 

Charms Bar < > + <C>

Sharing pane < > + <H>

Settings pane < > + <I>

Devices pane < > + <K>
Jump to last app < > + <Tab>

 Basic Commands 
Search apps < > + <Q>

Search files < > + <F>

Search settings and < > + <W>
control panels 

Lock computer < > + <L>

Print < > + <P>

File Explorer < > + <E>

Display options for < > + <P>
second screen 

Move app one display < >+ <PgUp>
to the left 

Move app one display < >+ <PgDn>
to the right 

Snap app to left < > + <←>

Snap app to right < > + <→>

Power user menu < > + <X>
Windows Run < > + <R>

 Desktop shortcuts 
Desktop < > + <D>

Maximize < > + <↑>

Minimize/Restore < > + <↓>

Switch between apps <Alt> + <Tab> 

Minimize all windows < > + <M> 
Show/Hide <Alt> + <P> 
Preview Pane 

Start Screen Apps
• To Open the Start Screen: Place your cursor in the

lower left corner of the screen and click the Start
screen icon. Or, press < >. Or, view the Charms
Bar and click Start.

• To View the Charms Bar: Place your cursor in the
upper right or lower right corner of the window. Or,
press  < > + <C>.

• To Zoom Out from the Start Screen: Point to the
bottom right corner, and click the Summary View
button. Or, press <Ctrl> + < - >. Tiles are now easy
to arrange and group.

• To Resize App Tile on the Start Screen: Right-click
a tile and click Smaller to make the tile smaller.
Choose Larger to make the tile larger.

• To Rearrange Tiles: Tiles are organized into
columns of related apps. Drag a tile to a new location
in a column, or drag it between columns to start a
new column.

• To Remove a Tile from the Start Screen: Right-
click the app and click Unpin from Start.

• To Add a Tile to the Start Screen: Right-click the
app and select Pin to Start in the bottom bar.

• To Stop Updating an App’s Live Tile: Right-click
an app’s tile and click Turn live tile off.

• To Search for Files or Settings: Point to the top
right corner of the screen, click Search, and click
either Files or Settings. Or, press < > + <F> for
files; press < > + <Q> for settings.

• To Launch an App: Find the app’s tile on the Start
screen, or search for the app, and click its icon.

• To Search for an App: On the Start screen, start
typing the app’s name. Or, point to the top right
corner of the screen and click Search. Or, press
< > + <Q> and click Apps.

• To View All Installed Apps: Right-click the Start
screen and click All apps in the bottom bar. Or,
press < > + <Q> and click Apps. Or, view the
Charms bar, click Search, and click Apps.

• To Close an App: Point to the top of the screen to
make the grabber handle appear. Click and drag all
the way down the screen. Or, press <Alt> + <F4>.

• To Jump to an Open App: Place your cursor in the
upper left corner of the screen and click the app icon
that appears. Or, press < > + <Tab>. To view all
open apps, move your cursor from the corner down
the left edge, or press and hold down < > and
press <Tab> to scroll through open apps.
Note: Right-click an app and click Close to close it.

• To View App Commands: Right-click while inside
the app. A horizontal bar with options for the app,
such as tabs in Internet Explorer, appears.

• To Install an App: Install apps from the Windows
Store, media such as DVDs, or download from the
Internet.

• To Uninstall an App: Right-click the app and click
Uninstall in the bottom bar.
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Charms bar 
Point to corners on 
the right side of the 
screen to open the 
Charms bar, as 
shown here. 

Click a charm to 
begin working with 
common items and 
tasks. 

Account 
Click to switch to another account, 
lock the computer, or sign out. 

Navigate  
between apps 
Point here to jump 
to another app. 

Move the cursor 
down the left side of 
the screen to see 
all open apps. 

Start screen 
Point here to go to 
the Start screen. 

Tiles 
Click a tile to 
open an app. 

Summary View button 
Click to zoom out the Start screen, 
making it easier to arrange tiles. 

Scroll bar 
Click and drag to view other 
columns on the Start screen. 



Desktop Charms Bar 

• The Desktop is familiar from previous versions of Windows. Desktop
applications like Microsoft Office, File Explorer, and the Controls Panel run
here. Use the same keystroke shortcuts, corner hotspots, and charms bar you
use in Windows 8 to navigate the desktop.

• To Use the Desktop: From the Start screen, click the Desktop tile. Or, press
< > + <D>.

• To Peek at Open Windows: Point to a program icon on the taskbar. Point at
the resulting thumbnail preview to peek at the window.

• To Minimize Other Windows: Click and drag a window's title bar quickly
from side to side. Or, press < > + <Home>.

• To Compare Windows Side by Side: Click and drag a window's title bar to
the right side of the screen, and drag the other window to the left side of the
screen. Or, press < > + <→>  or  < > + <←> .

• To Maximize an Open Window: Click and drag the window's title bar to the
top of the screen or, drag the bottom border of the window down to the
taskbar. Or, press < > + <↑> .

• To Switch Between Apps: Press <Alt> + <Tab> to move quickly between
open programs and windows on the desktop.

• To Access the Control Panel: Open the Charms bar from the desktop. Click
the Settings charm and click Control Panel.

• To Pin a Program to the Taskbar: Pin your favorite desktop apps to the
taskbar so you can open them from within the desktop. Open the program you
want to pin, right-click the program icon on the taskbar and select Pin this
program to taskbar.

 Settings and Personalization 
• To Personalize your PC: Open the Settings charm. Click PC Settings, and

click the Personalize category. There are three basic ways to personalize
your account:
Lock screen: Change the image that appears when the screen is locked.
Start screen: Change the color scheme and graphics of the Start screen.
Account picture: Use a picture on file as your account picture.

• To Change PC Settings: Open the Computer window (click the Start button
and select Computer). Right-click the disk you want to defragment and select
Properties from the contextual menu. Click the Tools tab and click the
Defragment now button.

• To Change Settings of Apps that do not Run on the Desktop: Open the
app and open the Settings charm. App specific settings are displayed, such
as changing preferences, finding help, and adding accounts.

• To Sync your Settings: When your settings are synced, you can log in to
your account from another PC and have the same settings. Open the
Settings charm. Click PC Settings, and click the General category. Scroll
down to the “Refresh your PC without affecting your files” heading and click
Get started.

Charms help you do the things you do most often. What you can do with charms 
changes, depending on if you’re on the Start screen or using an app. 

Search: Use the search charm to search for anything on your 
computer. Search within a specific app, or search the entire 
computer. For example, if the Mail app is open, you can search 
for a specific message. Or, if you open the charm from the Start 
screen, search your entire PC. 

Share: Use the Share charm to share things with other people—
such as photos, documents, or links-- without leaving the app. 

Start: Click to jump to the Start screen. If the Start screen is 
already displayed, return to the last app you were using. 

Devices: Go here to use any device that’s connected to your 
computer. For example, to print a file on a printer, to import 
images from a camera, and to manage a wireless device. 
Settings: Change settings, find help, and get info for your PC and 
apps here. Also find the most common PC settings: volume, 
brightness, notifications, power, network connection, and 
keyboard. Access settings at a deeper level for your computer 
under Change PC Settings, such as personalization, users, 
notifications, ease of access, privacy, and much more. 

 Search 
• Not sure where something is? Use the search charm. It can help you find the

settings, files, and apps you want on your computer. It can also help you find
specific settings and items within an app.

• To Open Search: Open the Charms bar and click Search. Enter the search
term, and click Apps, Settings, or Files to view the search results for each
category.

• To Search Within an App: Open the Charms bar and enter the search term
in the Search box. Click an app in the Search pane to perform the search in
an app, instead of in apps, settings, and files on the computer. For example,
click the Bing app to perform the search in Bing.

• To Open a Location in File Explorer: Open the Search charm. With Apps
selected, enter a drive in the search box (e.g. C:\ or
\\server\share). A list of folders within that drive appears below the
search box. Press the Down Arrow key to select a folder. Continue entering
the file path, typing and selecting folders as needed. Press <Enter> to open
the path in File Explorer.

• To View Details for an Item in Search Results: Point to the item. A screen
tip with more details about the item is displayed.

• To Get Help: Getting help changes depending on where you are:
Desktop: Open the Search charm, type Help, and click Help and Support.
Start screen: Open the Settings charm, and click Help.
App: Open the Settings charm, and click Help.

 Maintenance 
• To Refresh your PC: Open the Settings charm. Click PC Settings, and

click the General category. Scroll down to the “Refresh your PC without
affecting your files” heading and click Get started.

• To Shut Down your Computer: By default, Windows 8 goes into sleep mode
when a laptop is closed, or the power button is pressed on a tablet. To turn
your PC completely off, close all desktop apps. Then open the Settings
charm, click Power and select Shut Down.

• Windows Defender is included in Windows 8 by default. This free anti-virus
program protects our computer from downloading viruses and other malware
to your computer.
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Microsoft® 

Windows 7 
Quick Reference Card 
Windows Explorer Keystroke shortcuts 

General 
Start menu < > 
My Computer < > + <E>
Create new folder <Ctrl> + <Shift>

+ <N>
Zoom < > + <+> 
Connect to projector < > + <P> 
Flip 3D < > + <Tab>

 Window management 
Peek at the desktop < > + <Space>

Show/Hide desktop < > + <D>
Minimize all windows < > + <M> 

Minimize other  < > + <Home> 
windows 

Maximize < > + <↑>
Minimize/Restore < > + <↓>
Dock to left < > + <←>
Dock to right < > + <→>

Jump to left monitor < > + <Shift>
+ <←>

Jump to right monitor < > + <Shift>
+ <→>

Show/Hide <Alt> + <P>
Preview Pane 

Bring all gadgets < > + <G>
to the front 

 Taskbar 
Cycle through icons  < > + <T> 
Open new instance <Shift> + click 

Launch program < > + <1-9>
(# corresponds to pin order) 

• To Search for a File or Program on the
Computer: Click the Start button, or press < >,
and type a keyword for the file or program. Search
results are displayed in the menu.

• To Search for a File in a Folder or
Library: Open the folder or library you want to
search. Click the Search box in the upper right
corner of the window and enter keyword(s) for the
file you want to find.

• To Add a Search Filter: After entering
keywords in the Search box, select a filter from the
list that appears.

• To Add a Folder to a Library: Open the
library and click the locations link. Click the Add
button. Select the folder and click Include folder.

• To Create a New Library: Open Computer
and select Libraries in the Navigation pane. Click
the New library button on the toolbar. Enter a name
for the library press <Enter>. Double-click the library
and select the folders you want to include.

• To Change How Items are Displayed:
Click the  Change your view button list arrow 
on the toolbar and select a view. 

• To Change Window Layout: Click the
Organize button on the toolbar, point to Layout, and
select a layout option.

• To Create a Folder: Click the New Folder
button on the toolbar. Type a name for the folder and
press <Enter>.

• To Use the Address Bar to Navigate:
Click a location on the Address bar to go to view it in
the window. Click a location’s list arrow to view and
open subfolders within the location.

• To Preview a File: Click the  Preview Pane
button on the toolbar or press <Alt> + <P>. Select
the file you want to preview.

• To View a File or Folder’s Properties: 
Select the file or folder and view properties in the
Details pane.

Windows Taskbar 

Search box 
Enter keywords to 
search the folder. 

Details pane 
Displays details 
about selected files. 

Title bar 
Click and drag to 
move the window. 

Toolbar 
Displays buttons 
and menus for 
common 
commands. 

Navigation Pane 
Provides quick 
navigation to 
folders and files. 
Browse to favorite 
locations, libraries, 
homegroups, 
Computer, and the 
network. 

Address bar 
Displays the location of the 
folder that is currently open. 

Notification area: The Action Center, clock, and 
other system icons are located here. 

Window preview:  
Point to the program 
icon on the taskbar. 
Click a preview 
thumbnail to view 
the window. 

Start button:  
Opens the Start menu. 

Program icon: Click to open the program. 
Rearrange icons by clicking and dragging. 

Show Desktop button:
Point or click here to
make open windows

invisible.
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Aero Jump Lists 

• To See Through Windows with Aero Peek: Point to the Show
Desktop button on the right edge of the taskbar or press < > + <Space>.

• To View Open Windows with Aero Peek: Point to the program
icon on the taskbar that contains the file or window you want to view. Click the
thumbnail preview to view the window.

• To Minimize Other Windows with Aero Shake: Click and drag a
window's title bar quickly from side to side. Or, press < > + <Home>.

• To Compare Windows Side by Side with Aero Snap: Click and
drag a window's title bar to the right side of the screen, and drag the other
window to the left side of the screen. Or, press < > + <→>  and
< > + <←> .

• To Maximize an Open Window with Aero Snap: Click and drag
the window's title bar to the top of the screen or, drag the bottom border of the
window down to the taskbar. Or, press < > + <↑> .

• To Flip through Windows with Flip 3D: Press < > + <Tab>;
continue to hold down the < > key while pressing <Tab> to scroll through
the open windows.

 Personalization  
• To Personalize Windows 7 Appearance and Sounds:

Right-click the desktop and select Personalize. The Personalization window
appears. Click the appropriate links to personalize these settings:

• Themes – Change menus, icons, backgrounds and sounds all at once.

• Desktop Background – Choose built-in colors and pictures, or use your own.
Select more than one picture to start a slide show.

• Window Color – Change window color and transparency.

• Sounds – Change which sounds play when you perform different tasks.

• Screen Savers – Adjust what it displays and when it appears.

• Desktop Icons – Add icons to the desktop, such as Computer and Network.

• Mouse Pointers – Change how the pointer looks and acts, reverse buttons.

 Maintenance 
• To Defragment your Hard Disk: Open the Computer window (click

the Start button and select Computer). Right-click the disk you want to
defragment and select Properties from the contextual menu. Click the Tools
tab and click the Defragment now button.

• To Use Disk Cleanup to Free Space on Your Hard Drive:
Open the Computer window (click the Start button and select Computer),
right-click the hard disk, select Properties from the contextual menu and click
the Disk Cleanup button.

• To Uninstall a Program: Click the Start button and select Control
Panel. Click the Uninstall a program link under Programs. Select the
program you wish to uninstall from your computer, and click the Uninstall
button on the toolbar.

• Jump Lists are quick shortcuts to files and commands that a program uses
frequently. The items that appear in a jump list change according to the
program selected. For example, Internet Explorer displays frequently visited
pages, Microsoft Word displays frequently opened documents.

• To View a Jump List: Right-click an icon on the Windows 7 taskbar. Or,
click the list arrow next to a program icon in the Start menu.

• To Pin a Program to the Taskbar: Open the program you want to
pin, right-click the program icon on the taskbar and select Pin this program
to taskbar from the jump list.

• To Pin an Item to the Jump List: View the program jump list. Right-
click the item you want to pin and select Pin to this list. Or, point to an item
on the jump list and click the  Pin to this list button.

• To Remove an Item from the Jump List: View the program jump
list. Right-click an item that appears in the jump list and select Remove from
this list from the contextual menu.

 Gadgets  
• To Add Gadgets to the Desktop: Right-click the desktop and select

Gadgets from the contextual menu. Double-click the gadget you want to add
to the desktop.

• To View Gadgets: Press < > + <G>. The gadgets on your desktop
appear on top of the windows that are open.

• To Remove a Gadget from the Desktop: Point to a gadget and
click the Close button that appears.

• To Download New Gadgets: Right-click the desktop and select
Gadgets from the contextual menu. Click the Get more gadgets online link
at the bottom of the window, click the Desktop gadgets tab, and click the
Download button for the gadget you want to add.

• To View a Gadget’s Options: Point at the gadget, then click the
Options button to view and change settings for that gadget.

 HomeGroup 
• To Join a Homegroup: Before you begin, make sure you have the

homegroup password. Click the Start button and select Control Panel. Click
the Network and Internet link. Click the HomeGroup link and click Join
Now. Complete the wizard and enter the homegroup password as prompted.

• To Create a Homegroup: Click the Start button and select Control
Panel. Click the Network and Internet link. Click the HomeGroup link and
click Create a homegroup. Complete the wizard to create the homegroup.

Aero Peek makes open 
windows invisible so you 
can view the gadgets and 
icons on the desktop.  

Right-click an icon 
on the taskbar… 

…to view the jump list 
for the program. 

Items at the top of 
the list are pinned to 
the program’s 
 jump list.  

The Frequent 
section displays 
files or pages that 
have been 
frequently used.  
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Acrobat: Find and Advanced Search tools 
Caution: when scanned paper is turned into PDF format, it can be made searchable through a process called 
“OCR” (Optical Character Recognition).  OCR will try and translate an image to text, but it can be inaccurate, 
especially when dealing with poorer quality images.  When searching PDF files you might not get a complete set 
of results. 

Find 
• Go to the Edit menu and select Find or press Ctrl+F.
• Your cursor will move to the Find box on the toolbar.
• Enter text – each time you press the enter key, it will go to that text in the PDF file.

Advanced Search 
• Go to the Edit menu and select Advanced Search or press Shift+Ctrl+F.
• A search window will appear enabling you to look for search terms in multiple PDFs. For

example, you can search across all PDFs in a specific location or all files.
• With Standard or Pro, you can save your search results to a PDF or CSV (spreadsheet) file.

*Recognize Text (a.k.a. OCR or Optical Character Recognition)

• If a PDF is not searchable you can make it so by running the “Recognize Text” process.

• From the “Tools” pane select “Recognize Text”.  You can run the process on a single file, or
multiple files.

*Bookmarks
• A “bookmark” is a link with text in the “Bookmarks” panel.  Each bookmark goes to a different

view or page in the document, and allows one to jump to a destination in the PDF, to another
document, or to a webpage.  They can function as a table of contents.

• Bookmarks can also be used to create document breaks within a PDF.  This is also called
unitizing, and by bookmarking a PDF you can allow people to review pages on a document level
in addition to a page level.  We suggest that a bookmark with the bates number as the name of
the bookmark be used to label each new document within the PDF file.

*Comments (a.k.a. Annotations or Sticky Notes)

• Comments are notes and drawings that communicate ideas or provide feedback for the PDF files.
You can type a text message using the Sticky Note tool, or you can use a drawing tool to add a
line, circle, or other shape and then type a message in the associated pop-up note.

• Most comments include two parts: the icon, or markup, that appears on the page, and the text
message that appears in a pop-up note when you click or double-click the icon or place the
pointer over the icon.

* Not available in the free Acrobat Reader



Acrobat Pro 
Document re-organization / unitization 

If your PDF file contains a number of documents, you may split the file into individual documents using this 
technique. 

1. Create a bookmark for the beginning page of each new document in your file.
a. The bookmark names will become the new file names.
b. Give a unique name to each bookmark (so that the new file names will also be unique).

i. If the pages are bates numbered, consider using the bates number as a prefix for the bookmark
name.

ii. Do not use any extraneous punctuation marks in the bookmark names as this may cause a
conflict during the splitting process.
(no “?!\“&’^%” characters, dashes “-“ and underscores “_” are okay).

2. Set up the split:
a. Acrobat DC Pro:  From the “Tools” tab or side menu…choose “Organize Pages”, then select

“Split”.
b. Acrobat 11 or lower:  Select “Split” from the “pages” group in “Tools”.
c. Choose Split by “Top Level Bookmarks” from the drop down menu, the click on the “Output

Options” button.
d. Choose “Use bookmark names for file names” and click “OK”.

3. Run the split:
a. Acrobat DC:  click the “Split” button next to “Output Options”.
b. Acrobat 11 or lower:  Click “OK” in the “Split Document” dialog window.

Acrobat DC: 

Acrobat 11 or lower: 



F I L E  M E N U

Open........................................................................................Ctrl+O

Create PDF from File..................................................Ctrl+N

Create PDF from Web Page.................. Shift+Ctrl+O

Save........................................................................................... Ctrl+S

Save As..................................................................... Shift+Ctrl+S

Close.......................................................................................Ctrl+W

Close All.....................................................................Alt+Ctrl+W

Properties............................................................................Ctrl+D

Print............................................................................................Ctrl+P

Exit.............................................................................................Ctrl+Q

E D I T  M E N U

Undo.........................................................................................Ctrl+Z

Redo............................................................................Shift+Ctrl+Z

Cut, Copy, Paste................................................ Ctrl+X, C, V

Select All............................................................................... Ctrl+A

Deselect All.......................................................... Shift+Ctrl+A

Check Spelling...........................................................................F7

Find............................................................................................ Ctrl+F

Advanced Search.............................................Shift+Ctrl+F

Preferences...............................................................Ctrl+ , or K

T O O L S  P A N E

Type Tool..........................................................................................T

Insert Blank Page........................................... Shift+Ctrl+Q

Preflight....................................................................Shift+Ctrl+X

Edit Forms.............................................................. Shift+Ctrl+7

V I E W  M E N U

Rotate View  or ............................. Sh+Ctrl+ + or –
First/Last Page...............................................Home or End

Previous/Next Page................................................ or 

Page............................................................................Shift+Ctrl+N

Previous/Next View......................................Alt+ or 

Automatically Scroll.....................................Shift+Ctrl+H

Zoom To................................................................................Ctrl+Y

Actual Size............................................................................ Ctrl+1

Zoom to Page Level....................................................Ctrl+0

Fit Width................................................................................ Ctrl+2

Fit Visible...............................................................................Ctrl+3

Reflow......................................................................................Ctrl+4

Navigation Pane.......................................................................F4

Properties Bar...................................................................Ctrl+E

Toolbars..........................................................................................F8

Menu Bar.......................................................................................F9

Grid............................................................................................Ctrl+U

Snap to Grid.........................................................Shift+Ctrl+U

Rulers........................................................................................Ctrl+R

Line Weight.........................................................................Ctrl+5

Read Mode........................................................................Ctrl+H

Full Screen Mode..........................................................Ctrl+L

Activate Read Out Loud............................Shift+Ctrl+Y

Read This Page Only.................................... Shift+Ctrl+V

Stop (Reading)....................................................Shift+Ctrl+E

N A V I G A T I O N

Return to Hand or Select Tool..................................Esc

Next Search Result................................................................F3

Next Open Document...........................................Ctrl+F6

Previous Open Document....................Shift+Ctrl+F6

N A V I G A T I O N  P A N E L S

Insert Pages from File.....................................Shift+Ctrl+I

Insert Blank Pages......................................... Shift+Ctrl+Q

Delete Pages.......................................................Shift+Ctrl+D

Crop Pages............................................................. Shift+Ctrl+T

Rotate Pages....................................................... Shift+Ctrl+R

New Bookmark...............................................................Ctrl+B

W I N D O W  M E N U

Cascade..................................................................... Shift+Ctrl+J

Tile Horizontally............................................... Shift+Ctrl+K

Tile Vertically.......................................................Shift+Ctrl+L

C O M M E N T  P A N E

Add Sticky Note..............................................................Ctrl+6

Highlight Text...............................................................................U

Add Stamp........................................................................................J

Next Comment......................................................................Tab

Previous Comment.............................................. Shift+Tab

E F F I C I E N T  Z O O M  &  P A N

Drag Mouse to Zoom............................Ctrl+Spacebar

Pan the View.............................................................Spacebar

Zoom In/Out............................................................Ctrl + or –

Adobe Acrobat DC shortcuts frequently-used on Windows



A C R O B A T  M E N U

Quit.......................................................................................Cmd+Q

Preferences.............................................................Cmd+, or K

F I L E  M E N U

Open....................................................................................Cmd+O

Create PDF from File.............................................. Cmd+N

Create PDF from Web Page...............Shift+Cmd+O

Close...................................................................................Cmd+W

Save........................................................................................Cmd+S

Save As..................................................................Shift+Cmd+S

Properties........................................................................ Cmd+D

Print........................................................................................ Cmd+P

E D I T  M E N U

Undo..................................................................................... Cmd+Z

Redo........................................................................ Shift+Cmd+Z

Cut, Copy, Paste.............................................Cmd+X, C, V

Select All............................................................................Cmd+A

Deselect All.......................................................Shift+Cmd+A

Check Spelling...........................................................................F7

Find.........................................................................................Cmd+F

Advanced Search......................................... Shift+Cmd+F

Preflight................................................................Shift+Cmd+X

T O O L S  P A N E

Type Tool..........................................................................................T

Insert Blank Page........................................Shift+Cmd+Q

Edit Forms...........................................................Shift+Cmd+7

V I E W  M E N U

Rotate View  or ..........................Sh+Cmd+ + or –
First/Last Page...............................................Home or End

Previous/Next Page................................................ or 

Page........................................................................ Shift+Cmd+N

Previous/Next View.................................Cmd+ or 

Automatically Scroll................................. Shift+Cmd+H

Zoom To.............................................................................Cmd+Y

Actual Size.........................................................................Cmd+1

Zoom to Page Level................................................Cmd+0

Fit Width.............................................................................Cmd+2

Fit Visible............................................................................Cmd+3

Reflow..................................................................................Cmd+4

Navigation Pane.......................................................................F4

Properties Bar............................................................... Cmd+E

Toolbars..........................................................................................F8

Menu Bar..........................................................Shift+Cmd+M

Grid........................................................................................ Cmd+U

Snap to Grid..................................................... Shift+Cmd+U

Rulers....................................................................................Cmd+R

Line Weight......................................................................Cmd+5

Read Mode...................................................... Shift+Cmd+H

Full Screen Mode.......................................................Cmd+L

Activate Read Out Loud........................ Shift+Cmd+Y

Read This Page Only.................................Shift+Cmd+V

Stop (Reading)................................................ Shift+Cmd+E

N A V I G A T I O N

Return to Hand or Select Tool..................................Esc

Next Search Result................................................................F3

Next Open Document....................................... Cmd+F6

Previous Open Document................Shift+Cmd+F6

N A V I G A T I O N  P A N E L S

Insert Pages from File................................. Shift+Cmd+I

Insert Blank Pages......................................Shift+Cmd+Q

Delete Pages................................................... Shift+Cmd+D

Crop Pages..........................................................Shift+Cmd+T

Rotate Pages....................................................Shift+Cmd+R

New Bookmark...........................................................Cmd+B

W I N D O W  M E N U

Minimize..........................................................................Cmd+M

Cascade..................................................................Shift+Cmd+J

Tile Horizontally............................................Shift+Cmd+K

Tile Vertically................................................... Shift+Cmd+L

C O M M E N T  P A N E

Add Sticky Note..........................................................Cmd+6

Highlight Text...............................................................................U

Next Comment......................................................................Tab

Previous Comment.............................................. Shift+Tab

E F F I C I E N T  Z O O M  &  P A N

Drag Mouse to Zoom........................Cmd+Spacebar

Pan the view..............................................................Spacebar

Zoom In/Out.........................................................Cmd + or –

Adobe Acrobat DC shortcuts frequently-used on Mac



Viewing Search Results 
After a search, dtSearch will display the results of the search. The top half of the dtSearch window will list all of the 
files retrieved in the search, and the lower half will show the first document in the list, with hits highlighted in 
yellow. 

1. To select a document to view from the search results list, double-click on it.
2. To jump to the next hit in a document window, click Next Hit on the button bar (or press SPACEBAR). Press Ctrl-

SPACEBAR, or click the Next Doc button, to go to the next document.
3. To change the way search results are sorted, click on one of the column headers (Name, Score, Location, Date,

etc.).
4. Click the Launch button to open a document in the application associated with it. For example, a Word

document would be launched in Microsoft Word.

To view or reuse a prior search request, click the Search History tab in the Search dialog box. 

Create a Quick Summary of Your Search Results 
An easy way to see all hits in all retrieved documents is to build a search report. A search report shows all hits along 
with the amount of context that you request. 
1. Choose Search Report from the Search menu. The Generate Search Report dialog box will appear.
2. Enter the number of words (or paragraphs) of context that you want dtSearch to include in your search report

and click OK to generate the report.
3. The search report will open in your word processor so you can edit or print it

dtSearch Quick Start 
To get started with dtSearch, the first step is to build an index of your documents.   Once the index is built, dtSearch 
can use it to search your documents quickly. 

Indexing Documents 
1. Choose Create Index from the Index menu.
2. In the Create index dialog box, enter a name for the index and click OK.

3. dtSearch will ask if you want to add documents to the index. Click Yes to go to the Update Index dialog box.

4. Click Add folder... to add a folder to the list of folders to index.
5. Click Start Indexing to begin adding documents to your index.

dtSearch automatically recognizes many popular file types. For a complete list of the file formats that dtSearch
supports, see the dtSearch website.

Updating an Index 
If you edit or add to your documents, you will need to update your index to reflect the changes. 

To update your index, choose Update Index in the Index menu (or press Ctrl-U). Check the Index new or modified 
documents box and the Remove deleted documents box, and then click the Start Indexing button. 

To schedule automatic index updates, click Index > Index Manager and click the Schedule Updates.



Searching using the Index 
1. Click the Search button on the dtSearch button bar, or press Ctrl-S, to open the Search dialog box.

2. Enter a search under Search Request.
3. Select any items under Search features (such as fuzzy searching) that you want to use.
4. Click Search to begin the search.

Search Types 
Any words: use quotation marks around phrases, put + (plus) in front of any word or phrase that is required, 
and - (minus) in front of a word or phrase to exclude it.  Examples: 

banana pear "apple pie" 
"apple pie" -salad +"ice cream" 

All words:  like an "any words" search except that all of the words in the search request must be present for a 
document to be retrieved. 

Boolean search: a group of words, phrases, or macros linked by connectors such as AND and OR that indicate the 
relationship between them.   Examples: 

Search Request Meaning 

apple and pear both words must be present 

apple or pear either word can be present 

apple w/5 pear apple must occur within 5 words of pear 

apple not w/5 pear apple must occur, but not within 5 words of pear 

apple and not pear only apple must be present 

name contains smith the field name must contain smith 

If you use more than one connector, use parentheses to indicate precisely what you want to search for.  For 
example, apple and pear or orange juice could mean (apple and pear) or orange, or it could mean apple and (pear or 
orange).  

You can use variable term weighting in a search request to weigh some words more heavily than others in ranking 
search results. Example: apple:5 and pear:3 

Search Features 
Stemming searches other grammatical forms of the words in your search request. For example, with stemming 
enabled a search for applies would also find apply, applying or applied. 

Phonic search finds words that sound similar to words in your request, like Smith and Smythe. 

Fuzzy search sifts through scanning and typographical errors. Fuzziness adjusts from 1 to 10 depending on the 
degree of misspellings. A search for alphabet with a fuzziness of 1 would find alphaqet; with a fuzziness of 4, it 
would find both alphaqet and alpkaqet. 

Synonym searching tells dtSearch to use a thesaurus to automatically expand a search to include synonyms or 
related concepts, including three optional levels. (Click Browse thesaurus to browse the entire thesaurus.) 

To see how stemming, phonic searching, fuzzy searching or wildcards will affect your search, click the Browse 
Words button. 

To browse the thesaurus used for synonym searching, click the Browse Thesaurus button. 

Click the Fields button for a list of searchable fields, if you want to limit your search to a particular field. 

More Search Options 
To search without an index, or to search by filename, date, or size, click the More search options tab. 

Indexes to search 
The top right of the dialog box 
shows a list of the indexes you 

have created; select one or more 
to search 

Indexed word list 
The top left of the 
dialog box shows a 
list of the words in 

the currently 
selected index. If 

more than one index 
is selected for 

searching, you can 
select the index to 
display in the word 
list by clicking the 
down arrow above 

the word list. 

Search Request 
The words and 
phrases being 

searched 
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Quick Reference							           Litigation Services
Reports and Reportbooks
Creating and Printing Reports
Case spreadsheets are the raw material that make up your CaseMap reports — many of 
which are required by the court. With a few mouse clicks, you can create professional reports 
instantly in Adobe® Acrobat, Microsoft® Word, or just printing them on paper. Using the Facts 
spreadsheet you can easily turn your fact chronology into Motions for Summary Judgment 
and produce the list of facts that you’re willing to stipulate for pre-trial motions. With CaseMap 
reports, What-You-See-is-What-You-Get, so what is displayed in your spreadsheet view is the 
same as what you see in your report. Make sure you have filtered your spreadsheet content 
and sorted records to create the view you want before printing your reports.

CaseMap also offers four pre-built reports that you can easily produce using a wizard to guide 
you through the steps. Pre-built reports include the following options: Privilege Log, Summary 
Judgment, By Issue Report, By Object Report.

1. Creating a Case
Before working in CaseMap, you first need to create a case file to
store information regarding the matter.

To create a new case:
1. On the File menu, click New.
2.	 Follow steps in the wizard to set up case information.

• The time zone should reflect the primary location where your
case and most facts and events occur. 

• Add case users later once the case is created and any custom
fields or views are added.

• Save the case to a network folder so others can access it.
3. Click Finish to create the new case file and launch the new Case 

Jumpstart Wizard.

2. Creating a Cast of Characters
CaseMap’s objects spreadsheets are used to organize your list 
of “nouns” and Cast of Characters regarding the case, including 
persons, places, events, documents, evidence, proceedings, and 
pleadings.

Short Names:
When names are entered, CaseMap automatically creates short 
names - unique names for each object entered in a case. Short 
names are what make linking case data possible. When a short name 
is identified, CaseMap automatically links the object to case informa-
tion: facts, issues, questions, and research. This feature is what allows 
you to search and view data in various ways so you can quickly locate 
essential information and create reports that shape and support 
your case strategy. For more information and tips on short names, 
see the CaseMap Answer Center.

• Cast of Characters
• Client Interviews
• Case Issues
• Documents
• Pleadings
• Depositions
• Exhibits
• Research
• And more

OUTPUTINPUT

CaseMap® Workflow

ReportBooks

TimeMap®

Custom Reports

• Analyze data: complete spreadsheet fields
• Sort spreadsheet data
• Search case data
• Review and annotate in DocManager
• Filter spreadsheet data to create reports

Case Analysis

 To enter a basic Cast of Characters:
1. In the Case Jumpstart Wizard, click on the appropriate link to 

type in your character name. The wizard provides pages for
Litigants, Judges, Opposing Counsel, Witnesses, Other People, 
and Other Organizations.

2.	 When you’re done, click Finish. The All Objects spreadsheet 
displays so you can review your Cast of Characters. Notice how 
each object has a short name created for it.

3. In the Case Shortcuts pane, click the All Shortcuts bar to view 
the Cast of Characters organized by sub-object spreadsheets.

3. Entering Issues
When you first create your case, start outlining your issues in the Issues 
spreadsheet so you can quickly develop a hierarchy of claims, counter-
claims, and any other known arguments. 
The Issues spreadsheet can hold as many levels or sub-issues as you 
want and is automatically numbered (1, 1.1, 1.1.1) to indicate main issues 
and sub-level items for a case.

To enter issues:
1.	 In the Case Shortcuts pane under Favorites, click on Issues.
2.	 In the Full Name field, type in an issue. 

CaseMap automatically creates a short name for the issue to 
link issues to fact records and other case data.

3. Click the New Record button and then click Issues or press the 
Insert key to enter in a new issue.

4.	 To create a sub-level issue, click the arrow                                   pointing to the 		
right. CaseMap automatically saves each record as you move to
a new field or record.

Creating and Setting Up a Case

To print to PDF:
1	 On the Reports menu, click Print or PDF 	

Current View. You can also click the 	
Print 	button on the CaseMap toolbar.

2	 On the submenu, click Print to PDF or 	
Print to PDF Email. The Print to PDF 	
Email option includes the PDF report in 	
an Outlook email that you can send to 	
case staff or clients.

To print to Word, Excel, TimeMap, 
NoteMap, HTML, or Corel WordPerfect:
1	 On the Reports menu, click Send
	 Current View To.
2	 On the submenu, click on the print option 	

you want.
Some options allow you to select either a 	
Grid or Record View. Try printing both to 	
see which view you prefer.

To print a CaseMap pre-built report:
1	 On the Reports menu, click the pre-built 	

report you want to print: Privilege Log, 	
Summary Judgment, By Issue Report, 	
By Object Report.

2	 When the report wizard launches, follow 	
the steps in each box.

3	 When you complete the wizard and the 	
report displays, you can save it as a Word 	
file to the network folder where you store 	

	 reports.

To print and view a ReportBook:
1	 On the Reports menu, click
	 ReportBooks.
2	 On the submenu, click the ReportBook 	

you want to print.
3	 On the print option submenu, click Print 	

to PDF or Print to PDF Email.
4	 In the Save As PDF dialog box, navigate 	

to the network folder where you save 	
reports, and then click Save.

5	 In the message box, click Yes or No to 
embed linked files. If you click Yes, select 	
which files you want to include in the 	
ReportBook, and then click OK.

6	 In the message box, click Yes to view the 	
	 ReportBook.
7	 In the Bookmarks pane, click on a

bookmark link to view that section of the
	 report.
8	 In the ReportBook PDF file, click the

paperclip icon in the lower left corner to 	
display embedded linked files.

9	 Double-click on a linked file to view it in its 	
native application.

Printing ReportBooks
ReportBooks are living documents that can be used throughout the life of the trial that are 
essential for ensuring that clients and case staff stay abreast of case developments and can 
readily collaborate in the case analysis process.

A ReportBook is a compilation of CaseMap reports packaged with optional elements such as a 
cover page, table of contents, confidentiality statement, introduction, and report-specific title 
pages. The layout is similar to the standard report generated when you print one of CaseMap’s 
spreadsheet views. CaseMap offers eight pre-built ReportBooks for you to choose from, 
including a complete Case Summary (as shown above) and an overview of What’s New in the 
Last 14 days.

ReportBooks are printed to a PDF file. You can choose whether to embed linked files in your 
ReportBook so that others can click on a document or file and view it in its native application.

Litigators use ReportBooks in a variety of ways:
• Produce a ReportBook shortly after client intake to show clients that you have captured

their concerns.
• Compile a ReportBook to present your case to investigators, arbitrators, clients, and other 

 key decision makers.
• Save your ReportBooks in PDF and link them to correspondence.

LexisNexis and the Knowledge Burst logo are registered trademarks of Reed Elsevier Properties Inc., used under license. CaseMap is a registered 
trademark of LexisNexis, a division of Reed Elsevier Inc. Other products or services may be trademarks or registered trademarks of their respective 
companies. © 2012 LexisNexis. All rights reserved.  LO19812-11-0612



Getting Data into CaseMap
CaseMap offers several ways to get case data into your case file.

 

    There are three main ways to get data into CaseMap:
• Manually entering data into spreadsheets
• Bulk importing data using the Import Linked Files Wizard 
•   �Sending facts and data from other programs (like Microsoft® Word, 

Microsoft® Outlook, Concordance®, TextMap®, and Adobe® Acrobat).

A. Manually Entering Data
As you gather new case information, you can manually create a new 
record on any spreadsheet to update the case. To create new record, 
press the Insert key or click the New Record button on the CaseMap 
toolbar. Records are saved automatically as you navigate from record 
to record. To re-sort the spreadsheet, click Refresh Table on the
Records menu.

Need CaseMap Training? Visit us at LexisNexis University: http://www.lexisnexis.com/university/litigation-solutions. To access a free trial or 
purchase a DocManager subscription, contact your sales representative at 866-316-8525 or email sales@lexisnexis.com.

C. Using the Send to CaseMap Tool
You can easily send fact text or documents directly to your case from
other programs. While building the chronology with facts linked to 
documents, you can enter fact details, link to case elements by using 
short names and issues, and mark the status of the new fact.

Steps for sending facts or documents are nearly identical for each 
product. For complete step-by-step instructions for all supported 
products, see the CaseMap Answer Center. 

To send a document from Adobe Acrobat or Reader:
1	 With your PDF file open, right-click in the document and click Send 	

PDF to CaseMap. 
2	 In the Send to CaseMap dialog box, select Document in the Object 	

Type list.

3	 �Type in the document name or edit the Full Name field, then click 
Save.

4	 In the Send to CaseMap dialog box, click Yes to view the new 		
document record in CaseMap.

Note: To send a fact, click the Send Fact to CaseMap in the PDF file.

To send facts and files from Word:
Send to CaseMap features display on a CaseMap ribbon within Word. 
The add-in is optional during CaseMap v10 installation.
1	 Open the CaseMap case that you want to import data into

	 from Word.
2	 In the Word document, highlight the information you want to 		

send, then click the Send to CaseMap - Add Fact button.

3	 When the Send to CaseMap utility launches, select the spreadsheet 	
	 you want and type in the document name, then click OK.
4	� In the Send to CaseMap – New Fact box, select Fact Text in the

Append Text Selection to field so that the excerpt displays in the 	
Facts spreadsheet.

Note: The text selected displays in the Text Selection field and is 	
enclosed in brackets. Do not delete the brackets. Removing them 	
prevents CaseMap’s recognition of short names and designate 	
actual document text for the import.

5	� In the Favorites Fields area, enter in additional fact record details 
like the date & time.

6	� Click the Issue Linker bar to link the record to an issue.
7	� Click OK to initiate the import process.
8	� In the message prompt, click Yes to view the new fact record in the 

Facts spreadsheet.
9	� Click in the Fact Text field to view the highlighted text you sent from 

the Word document.
10	�Click on the paperclip icon for the fact record to view the linked file 

path and open the file in Word.
11	� Scroll to the right and notice that the Source(s) field displays the 

linked element to the Word document and that the Linked Issue 
field displays any issues added for this record.

12	� Click on the Documents spreadsheet to view the record created 
for the linked Word file. If you only want to send the Word
document, click the Send to CaseMap – Add Object button.

Case Analysis
Analyzing case data tells you what you already know and points the way to important information that you may need to know more about. Searching, 
sorting, tagging, and filtering case information from various angles may offer insights not otherwise noticed.

A. Analyzing Spreadsheet Records
After getting data into Casemap, you’ll want 
to analyze spreadsheet records and com-
plete information in each field. For example, 
on the Facts spreadsheet, you’ll want to mark 
which facts are relevant (Material field) and 
whether the facts are disputed (Status field).

B. Sorting Fields
Sorting determines the order case elements display in a spreadsheet view, allowing you to review 
information in various ways to determine what items need to be addressed first or categorized 
based on the status of items. To sort a field, right-click on the field header (title), and then click Sort 
Ascending or Sort Descending. To sort multiple fields, click the Advanced Sort button and enter the 
fields you want to sort.
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C. Filtering Spreadsheet Records
Filtering allows you to cull data for reports or save filters to rerun later 
when additional information is added to the case. Records that meet 
the criterion of your filter remain in view on the current spreadsheet; 
while other records are temporarily hidden from view. You can filter by 
key words, field status setting, or create multi-level filters (key word + 
field status). You can also run pre-built filters from the Records menu, 
by clicking Filters and selecting an option from the submenu. The filter
menu options change depending on the spreadsheet you are viewing.
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E. Viewing Documents and Images in DocManager
Content analysis can be done in CaseMap’s DocManager near native image viewer. DocManager allows you to review and annotate documents 
and images without having to open the source file in its native application. You can add notes to annotations, edit annotations and notes, and also 
search annotation notes. Annotation colors can be changed by each user, but only one color is used for printing. When a search is run, search hits are 
highlighted in DocManager allowing you to review content and navigate between search hits. Current search hits are highlighted in blue. All other 
search hits are highlighted in yellow. You can then view and print the Linked File Text Hits and Review Linked File Hits reports. You can batch print 
linked document files with or without Bates stamps and choose whether to include annotations and notes in the printed output.

B. Importing Documents and Files into a Case
The Import Linked Files Wizard guides you through importing one or 
more documents/files into your case. The wizard will create a new 
record for each document you select to import. After the import, Case-
Map indexes all new file content. You can begin searching the updated 
case data as soon as the index process completes.

To bulk import documents:
1	� On the File menu, click Import and then click Linked Files from a 

Folder.
2	 In the Import Linked Files Wizard, click Next.
3	� In the Select Files to Import dialog box, click one of the import
	 options: Add Files or Add Folder.
4	� In the Select Files to Import dialog box, navigate to the folder 

where the files are saved, and select the file or folder to import, and 
then click Open. The files now display in the Selected files box. 

5	� After reviewing the files, click Next.
6	� �In the Spreadsheet drop-down list, click the spreadsheet for which 

you want to import the files, and then click Next.
7	� In the Ready to Import dialog box, review the files and spreadsheet 

you selected for the import.
8	� Click Next to initiate the import process.
9	 In the Completing the Import Linked Files Wizard dialog 
         box, review the number of files imported, then click Finish. 
         The new records display in the selected spreadsheet.
10	In the Completing the Import Linked Files Wizard dialog 
         box, review the number of files imported, then click Finish. 
         The new records display in the selected spreadsheet.
11	 In the Case Shortcuts pane, click on the spreadsheet.

A paperclip icon displays next to each record to indicate 	
	 that a linked file is attached.
12	 Click on the paperclip icon to view the file in its native

application or in the DocManager viewer.

The Web-based CaseMap Answer Center brings together helpful topics and useful information.  It’s all just a click away.
On the CaseMap Help menu, click Contents to launch the CaseMap Answer Center.

The Search Results navigation pane has four parts:
Search field — Allows you to type in full-text search terms.
Narrow Results panel — Allows you to view search hits found in spreadsheet 
fields, linked file text, or annotation note text. The number of search hits 
found displays to the right of the results.

To view a document or image file:
In a spreadsheet, click on the paperclip icon for the linked file you want to view. To view
multiple documents at one time, click the Pin icon in the upper right corner to this position.

To navigate search hits:
Click the Previous Hit and Next Hit buttons in the lower left corner of DocManager. You can 
also click on or type a number in the Page list to jump to that page.

To annotate documents or images:
1. Open a linked file in DocManager and click the Annotation mode button.
2. 	Click Annotate Text. You can also click the Tools menu and then click the first menu item 

on the shortcut menu, and click Annotate Text.
3. 	Drag your mouse pointer over the text you want to annotate to open the New Annotation 

dialog box. The text you selected now displays in the Document Text box.
4. 	In the Note tab, type in information you want and then click OK.

Tip: If the selected text is worthy of a new fact record, click the Create New fact button to
add it to the Facts spreadsheet.

Results panel — Displays all spreadsheets that contain records or linked files 
with search hits. The number of search hits found displays to the right of the 
spreadsheet name.
Resources panel — Provides access to three search results reports.

D. Searching Case Data
CaseMap allows you to quickly search case data because of the comprehensive index created 
during the import process. You can search and locate all instances or “hits” of your search terms in 
spreadsheet records, linked files, and annotation notes.

Search terms can be more than one word. They can also be numbers, text phrases, or a combined 
use of terms and search operators. To run a previous search or search by selected spreadsheets, 
click the Records menu and then click Full Text Search.

After a search is run, search results display in two areas in CaseMap: the Search Results pane and 
the spreadsheets pane. Print the Search ReportBook to create a report of each spreadsheet 
record and all linked files located based on your search query.
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